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The Office of Textbooks is responsible for coordinating the Adoption, Distribution,
Care and Use of Textbooks.

The Textbook Adoption Process Summary

The schools of Mississippi follow a five (5) year adoption cycle with the right of the
board, in its discretion, to renew or extend the contract from year to year for a
period not exceeding two (2) additional years, (Section 37-43-19 (c), Mississippi
Code of 1972, Annotated). The detailed steps of this process are as follows:

1. Subject areas are designated each year and placed on the Adoption
Cycle Calendar.

2. The MS Department of Education distributes the curriculum standards.
3. The publishers submit books for bid that meet the curriculum standards.
4. For each subject area, a seven member State Rating Committee reviews

the submitted books.

5. After the review process, the State Board of Education approves the
textbooks for adoption.

6. Copies of the adopted books are sent to schools by request to each
school district for administrators and teachers to review.
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7. The Textbook Caravan, travels throughout Mississippi to provide each
school district an opportunity to hear presentations about the newly
adopted books.

8. After reviewing the books and attending the presentations on State
Caravan, districts vote on which books they want to use in their schools.

9. Districts purchase the selected textbooks through the depository or
directly from the textbook company.

This is a summary. A detailed explanation of the adoption process can be found
on the web in the Textbook Adoption Handbook.

2015-2016 Textbook Adoption

Agriculture (C.T.E.), Health Education (C.T.E.) and Trade and Industrial Education
(C.T.E.)

PLEASE SAVE THE DATES: The 2015-2016 Textbook Caravan are tentatively
scheduled from

January 28, 2016 - February 8, 2016.

Please check the website for final schedule and registration information.
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Mississippi Accountability Standards-Textbooks

The school district is in compliance with state law and State Board of Education
policies for state adopted textbooks. {MS Code 37-43-1, 37-43-51, 37-9-14(2)(b).
and 37-7-301(ff)}

26.1 The school district provides each student in each school with current
or otherwise appropriate textbooks that are in good condition. {MS
Code 37-43-1, 37-9-14(2)(b), and 37-7-301(ff)}

26.2 Each school district shall keep an active and surplus inventory for each
school in the district to be completed by June 30 of each year. The
district shall report the inventory in the Textbook Inventory
Management System. {MS Code 37-43-51} (Refer to page A-12in the
Textbook Administration Handbook Rules and Regulations.)

The document can be downloaded from the welb at
http://www.mde.k12.ms.us/accred/accred

Codes of 1972 Annotated

The Mississippi Codes of 1972, Title 37 - Chapter 43 is the guidelines
used for textbooks. A complete document can be downloaded
from the Secretary of State’s website at www.sos.state.ms.us.

37-43-51. Reports by schools receiving textbooks

The management of all public, private, parochial or denominational schools
wherein the board is furnishing to the students thereof free school textbooks and
said free school textbooks are used by the students in said school, shall file
annually with the State Board of Education any and all reports as may be
required by the board.

Any person who shall refuse, neglect or fail to file any report required by the
board shall be denied a new allocation of funds until such reports have been
completed and filed with the board.
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What is TIMS?

TIMS is the web-based reporting system for the MS Department of Education
Office of Textbooks.

TIMS allows schools to report their active and surplus textbook inventory, as well
as transfer surplus books to other schools.

How do you sign up for TIMS?
TIMS1 form is used to designate a Primary and Secondary contact for your
District. The District Superintendent’s signature is required on this form.

TIMS2 form is used to request a user account in TIMS. The District’s Primary or
Secondary Contact signature is required on this form.

What is a school district able to do in TIMS?

Update Active
Request Surplus
Request a Transfer
Run Reports
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THE TEXTBOOK INVENTORY MANAGMENT SYSTEM (TIMS)
SCHOOL DISTRICT TIMS CONTACT MAINTENANCE FORM
(FORM TIMS-1 SUBMIT ONE FORM PER SCHOOL DISTRICT)

(Please Print or Type Information)

SCHOOL DISTRICT SCHOOL DISTRICT
HNAME: NUMBEE:

ADDRES:

CITY/STATE/ZID

PHOME: E-MAIL ADDRESS:

SUPERINTENDENT S

HNAME:

SUPERINTENDENT S

SIEIATURE: DATE:
({This must be an original signatore in blue ink)

(Circle Ome)

PRIMARY TIMS CONTACT NEW REQUEST CHANGE
PERSON
HAME:
TITLE:

E-MAIL
PHOME: ADDRESS:
AUTHORIZED SIGNATURE: DATE:

(This must be an original sipnature in blue nk)

(Circle One)
SECONDARY TIMS CONTACT PERSON NEW REQUEST CHANGE
HAME: TITLE:
E-MATL
PHOME: ADDRESS:
AUTHORIZED SIGNATURE: DATE:
(This must be an original signatore in bloe ink)
SEND COMPLETED FORM TO: SECURITY ADMINISTRATOR
MISSISSIFFI DEPARTMENT OF EDUCATION

EMATL: timsamde k12 ms s OFFICE OF TEXTBOOES
FAX- (601) 354-T500 P.O.BOX TT1
PHONE: (601) 576-4950 JACKSON, M5 30205

SECURITY ADMINISTRATOR USE ONLY:

APPROVED BY: DATE:

Revised 07/2015
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THE TEXTEOOK INVENTORY MANAGEMENT (TIMS)
USER SECURITY FROFILE
(FORM TIMS-I SUBMIT ONE FOEM FOR EACH TIMS USER)
(PLEASE PRINT OR TYPE INFORMATION)

DISTRICT DISTRICT
MAME: NUMBEE:
SCHOOL SCHOOL
MNAME: HNUMBER:
of Bequest (Check Cme):

NEW REQUEST
[[] MODIFY PROFILE OF EXISTING USER. REQUESTED
[ ] DELETE USER EFFECTIVE DATE:
MAME:
TITLE:
FHONE: E-MATIL ADDRESS:

BASED ON THE ACCESS FOLE DEFINITIONS, CHECE THE LEVEL (5) OF USE REQUIRED FOR. THIS USER:

[ TEXTBOOE COORDINATOR [ pRmCIPAL

DATE:
SIGNATURE OF AUTHORIZED Schoel District TIMS CONTACT FERSON

{This must be an eriginal signature in blue ink)

SEND COMPLETED FORM TO: SECURITY ADMINISTRATOR
MISSISSIFFI DEFARTMENT OF EDUCATION

EMAIL: tims@mde k12 ms us OFFICE OF TEXTBOOES
FAX: (601) 354-T590 PO.BOXK T
FHONE: (601) 576-4950 JACKSON, M5 30205

SECURITY ADMINISTEATOR USE ONLY:

APPROVED BY: DATE:

Eevised 07/2015
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How can a School District access TIMS?

1. Click on the following link
http://www.mde.k12.ms.us/ESE/TAP/tims

** MISSISSIPPI Site Guide A-Z | Transparency MS | MS.GOV | Eollow MDE | MDE Email
DEPARTMENT OF
| |EDUCATION o

Ensuring a bright ﬁ:tum for every child

PARENTS STUDENTS EDUCATORS

About MDE News & Media MS Schools Reports Public Notices Careers Contact Us Select MDE Office

uess’
ol
Business and Technology

Contemporary Health (K-8 Textbook Resources
g s

el Textbook Adoption and Procurement TIMS Log-on

Earlyr Childhood TIMS Information

Egrg:isr;/ligrr\’g::gz Arts TIMS (Textbook | " M £ Sust Subscribe to the TIMS List

roreign Language

Library Media (Textbook Inventory Management System) Schools

Literacy Adoption

Mathgmatics X »TIMS Log-on Caravan

Physical Education TIMS Security Form: User Profile Catalogs

Reading Fair
m—c—eg-—— TIMS Security Form: School District New Titles

Social Studies TIMS Contacts SSL Update
Standards for Professional Learning TIMS Users Guide oAt
Textbook Adoption and Procurement TIMS Users FAQ ;
Visual and Performing Arts Sl Coordinators

DISTRICTS

Home

.
IN THIS SECTION ' ‘ e

-
-

Curriculum and Instruction Home
- Staff

= Calendar

* Announcements

= Knowiedge Base

* iTunes U

* FAQ

.

-~y
CONTENT AREAS
Advanced Learning and Gifted ‘
Program:

OTHER LINKS « School Books Supply Company of
Approved Courses Manual Mississippi

C&lI SharePoint Site s <z

Common Core State Standards + aapSchoolDivision NASTA

CCSS SharePoint Site Adoption Schedule

Mississippi Virtual Public School
RESA Reqistration

Unpacking the CCSS for ELA
Doing What Works

DWW Box Access Instructions

Wiiting Project Collaborative

2012-2013 MSIS District Book
Request Manual
MDE Online Helpdesk

2. Click on TIMS Log-on
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Logon Screen

Logon

usemame: |
Password:

patavase: ([ R
cames

3. Enter Username
4. Enter Password
5. Database: MDED

6. Click Connect
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Getting Books into the system

Catalog table
(Only enter textbooks that are not already in the system.)

All textbooks must be entered on the catalog screen prior to adding to inventory. Adoption
textbooks are uploaded into TIMS by the Office of Technology and Strategic Services (OTSS).

Adding Textbooks to the Catalog

Information pertaining to all textbooks referenced by the TIMS system is stored in the Catalog
Table. Textbooks in this table are indexed by their ISBN numbers. In the event that an ISBN
cannot be located within TIMS, the textbook information must be added to the Catalog table.

M!nventow Requesis Transfers Inquiry Repors Query Record Security Help

—
’7] SubjectArea | p
Bublishers
*
@.’ MISSISSIPPI DEPARTMENT OF EDUCATION

TEXTBOOKS INVENTORY MANAGEMENT SYSTEM
TIMS

Mook Troveoory
Management Systemn

Click Maintain Tables on the TIMS file menu and choose Catalog.
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FEile Maintain Tables |nventory Requests Transfers |nquiry Reports Query Record Security Help

R RIROKC D o

MIS SIS SIPPI DEPARTMENT OF EDUCATION
= TEXTBOOK INVENTORY
TIM CATALOG

Lzt Iy
Munmpprnzs, Sraecta

isen-13 | (donot use dashes -) Edition Ind |Pupil Ediion_ ~|
ISBN-10 | (do not use dashes -}

Book Title
Publisher
Subject
SPED Indicator
Copyright
Book Grade
Age

Adoptive Ind | Non-Adoptive

Fiscal Year 2014

Transaction Date 07/15/2014

Cost
Inactive Ind | "]

Inactive Date

* Click Exit button( @'l) on the toolbar
* Enter a 13-digit ISBN

(If textbook information populates after entering ISBN, the textbook is already in the
system. See page 13 (Update Active) to add textbook to your inventory

* Select Pupil Edition or Teacher Edition from the Edition Ind menu.
(Please verify that you are choosing the correct Edition)
* Enter the Book Title and Publisher information.
* Double click or press F9 for listing of valid Subjects, click OK after selecting subject.
* Enter the Copyright year.

* Double click or press F9 for listing of valid Grades, click OK after selecting Grade.
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* Once all the necessary information has been entered, Save the information by choosing

Save from the File Menu or click on Save ( Q‘) icon on toolbar. “Transaction added
successfully” - Click OK

Inventory
(All books in a school’s possession should be added to this system)

Inventory information for all textbooks is stored in the Inventory tables.
These tables are divided into three types: Active, Surplus, and Disposal.
Information in these tables can be updated from the TIMS Inventory menu.

Update Active

File MaintainTabIesmgequests Transfers Inquiry EBepors Query BRecord Security Help

E’ Update Active oy

b

ko3

@f MISSISSIPPI DEPARTMENT OF EDUCATION
TEXTBOOKS INVENTORY MANAGEMENT SYSTEM
TIMS

Tesibook Lnveio: y
'\rl;an,\gu_*.“e-.n ‘_1'_\,-5]1‘_-|'|.'|

Click Inventory on the TIMS file menu and choose Update Active.
For Textbook Coordinators, a listing of schools in your district will appear.

Select your school and click OK, the Active Inventory form will appear, with school and district
information already entered.
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Update Active

File Maintain Tables |nwventory Requests Transfers Inguiry Reports Query Record Security Help

YR OKCIDE
ﬁ*’; MISSISSIPPI DEPARTMENT OF EDUCATION
= TEXTBOOK INVENTORY

TIMS ACTIVE

District Number | 0130 School Number | 028  School Phone 601 445-2917 Transaction Date |07/15/2014

School Name |HOWARD ELEMENTARY SCHOOL

ISBN-13 | 9780000000000 1SBN-10 |

Book Title |I‘u'1ARKET PANTRY Inactive Ind
Publisher |BhRNELL LOFT, LTD Fiscal Year | 2013 Book Grade | 04

** Add PE/TE Quantity

PE Qty TE Qty Edition E Copyright Year | 1990
Total PE Qty 75 Total TE Qty 0

* Enter ISBN and press tab key

* Once avalid ISBN has been selected, the gray textbook information fields will populate
automatically.

* Enter the quantity of textbooks in the PE Qty or TE Qty field. You will only be allowed to
enter information in one of these fields, depending on the ISB entered.

* Save the information by choosing Save from the File Menu or click on Save ( ﬁ‘) icon
on toolbar. “Transactions added/updated successfully” - Click OK

If you have more books to add/update, repeat steps above.

* Exit the form by selecting Exit from the File menu or Click Exit button ( @|) on the
toolbar.
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Transaction Processing

Request Process
(Surplus books)

Note: This menu is for making requests only.
The Requests menu will allow you to request surplus books from other schools.

(Requests for books may be made only once, therefore you should know beforehand how many
copies of a book you will need.)

Always enter the total number of books needed for each ISBN entered

If the system is unable to locate enough copies to fulfill your request, it will reserve as many
copies as possible, and place the remainder in the outstanding section (located on the Request
Surplus form).

TIMS USER MANUAL Revised 07/2015 Page 15



Request Surplus

File Maintain Tables Inventory BRtlPEEEN Transfers Inquiry Eeporis Query Record Security Help

‘ T IEQ E’ : f_\pproﬂquire equested‘ [
_ Approve Surplus Transfers
**
@.’ MISSISSIPPI DEPARTMENT OF EDUCATION

TEXTBOOKS INVENTORY MANAGEMENT SYSTEM
TIMS

Tescdoalk Liventory
hl;a||,1g|r|11crw "f\,g =

Click Requests on the TIMS file menu and choose Request Surplus.
If you are a Textbook Coordinator, select the school that will receive the textbooks and click OK.

School information in the Requester Information section will automatically populate.
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Request Surplus

File Maintain Tables Inventory Requests Transfers Inquiry Reports Query Record Security Help

=

P

«<

>®» =

MIS SIS SIPPI DEPARTMENT OF EDUCATION
TEXTBOOK INVENTORY
REQUEST SURPLUS

5y

Catalog Information

IHRW-PSYCHOLOGY: PRINCIPLES IN PRACTICE, 1998

ESNRERN0 780030154492

ISBN-10 | 0030154499 Edition P Copyright | 1998 Fiscal Year [ 2001  InactiveInd | N
Requester Information
NOTE: Dist | 0130 Sch Mo, | 020 Sch Name |MC LAURIN TEST SCHOOL
This form is for Needed Requested  Outstanding
requesting surplus Sch Phone |601 445-2953 PE Quantity | 5 | | 0
inventory only.
Date of Request |07/15/2014 TE Quantity | 0 | | 0
NOT FOR INQUIRING
OR SEARCHING FOR
Total | 5 | |
SURPLUS INVENTORY.
Location of Surplus
Dist Sch Mo. PE Qty Avl TE Qty Avl
[listrict Searnch
Sch Mame |
Statewide Search Dist Name |
City |
Sch Phone

* Enter avalid ISBN and press tab key

The Catalog Information section will automatically populate based on your selection.

Enter the number of textbooks needed into the PE Quantity or TE Quantity fields.
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Request Surplus

Idicirary =earch ]

S tatewide s.ear.:h]

* Click the District Search button or the Statewide Search button.

If textbooks are available within the selected district, the District Search button will be
highlighted for you to click.

If there are no textbooks available within the selected district, the Statewide Search button will
be highlighted.

If there are no textbooks available anywhere, a message will display indicating that there are no
books available in surplus for this ISBN.

| Forms

‘ There is no PE book available in the Surplus for
978032417180

* Once surplus inventory has been located and populated in the Request Surplus form,

Save the information by choosing Save from the File Menu or click on Save (%‘) icon
on toolbar. A message will display indicating that the transaction was added/updated
successfully.
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‘ Transaction{s) addediupdated successiully.

* Click OK. Exit the form by selecting Exit from the File menu, or Click Exit button ( @'1)
on the toolbar.
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Request Surplus

HIBIROKL D <

. MISSISSIPPI DEFARTMENT OF EDUCATION

= TEXTEBOOK INVENTORY
TIMS REQUEST SURPLUS
Catalog information
isen-13 [CIEIREREE) | [PH -MAGRUDER'S AMERICAN GOVERNMENT, 1999
ISBN-10 | 0134359852 Editsan P Copyright | 1999 Fiscal Year | 2001 Inmctrae nd IT
_Requalllr Information
NCTE Dist | 0130 Schho. | 020 Seh Name [MC LAURIN TEST SCHOOL
This form is far Needed — Requested  Oulstanding
PEgUESERAG SUplES Sch Phone [ﬁﬂ 445-2953 PE Cuantity - 20 20
Irventoey only
Date of est |(O7TMS2014 TE Cuanti o 1] 0
NOT FOR INQUIRING Lol ny | | |

OR SEARCHING FOR

SURFLUS INVENTORY. Total | 20 | <0 l
Location of Surplus
Dist [ 0130 Sch No. [044 FEQyad| 171 TEayad| 0
[Nistrict Search
Sch Name [EAST HOWARD HIGH SCHOOL
Stateaide Search Dist Name |HOWAHD SCHOOL DISTRICT
City [NATCHEZ
Sch Phone (601 4452863
Overview of Request Surplus form
- Catalog Information
- Requestor Information
- Location of Surplus
TIMS USER MANUAL Revised 07/2015 Page 20



Approve/Inquire Requested

File Maintain Tables Inventory gt i2:a60 Transfers Ingquiry Reports Query Record Security Help

P Request Surplus S
‘ I ILQ @ : Approvelinguire Requested L &
_ Approve Surplus Transfers
**
@ MISSISSIPPI DEPARTMENT OF EDUCATION

TEXTBOOKS INVENTORY MANAGEMENT SYSTEM
TIMS

Tesbook Lnvenibory
h-l;an,\;m_-n'lz:rvt .'jf_\,--sln-uh

To review inventory that your District has requested and to change the status of those requests
* Click Requests on the main menu

* Select Approve/Inquire Requested.
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Approve/Inquire Requested

i — MISSISSIPPI DEPARTMENT OF EDUCATION
: TEXTBOOKS INVENTORY
TIMS APPROVE / INQUIRE REQUESTED
B PE TE SchTotal  SchTotal Transfer
District  School Meeded — Needed MNeeded Requested Approval Transfer Reason for Denial
;)] ] | | ]
From From Regq Reg
Status Reason for Denial ISBN-13 ISBN-10  Dist Sch PEQty TEQty ReqDate
= = <1
- - &
Book Title | ] Edition | Copyright Year| |
Publisher | Book Grade | | Cost | | FiscalYear| | Inactivelnd |

Textbook Coordinator Role

Select School Number and the Approve/Inquire Requested form will display. You will Approve,
Deny or Pend a request.

Principal Role

The requested surplus for the selected school will display. Principals will view a request.
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Approve/Inquire Requested

File Maintain Tables Inventory Requests Transfers Inquiry Reports Query Record Security Help

HYRAEOK €D %

i MISSISSIPPI DEPARTMENT OF EDUCATION
== TEXTBOOKS INVENTORY
TIMS APPROVE / INQUIRE REQUESTED
e PE TE Sch Total Sch Total e
District ~ School  Needed Meeded Meeded Requested Approval Transfer Reason for Denial
o3 020 [ o [ 6 [ 633 [ 200 [va ] A |
From From Req Req
Status Reason for Denial ISBN-13 ISBN-10 Dist Sch PEQty TEQty ReqDate
-] I ENENaaaR R | 0020555183 || 1520 [ 008 || 0l 2[os10612014) 2
] (0021488231 1100 173 0[oei032014)
-] 5| 0/|05/19/2014)
PENDING -] 20| 0/05/15/2014]
[ DENIED =) Cannot Locate 0 1[0511512014)
APPROVED -] 14) 0/[0513/2014]
APPROVED - 10| 0/l05/06/2014]
APPROVED -] 5| 0/|05/06/2014)
APPROVED -] 10/ 0/|05/06/2014)
APPROVED -] 50| 0/[03/27/2014)
] ] I =
Book Title [SCIENCE SPECTRUM ] Edition Copyright Year
Publisher [HOLT, RINEHART & WINSTON | Book Grade | 09 | Cost| Tom e Inactive Ind [ N |

* The small scroll bar can be used to scroll through the Approve/Inquire Requested
entries, however the cursor must be on a specific ISBN in order to change information or
view catalog information.

* Textbook Coordinators may change the status of a surplus request to Approved,
Pending, Denied, or leave the status blank. Should the status for an ISBN be changed to
Denied, a reason must be selected from the Reason for Denial field.

Save the information by choosing Save from the File Menu or click on Save (%‘) icon on
toolbar.
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Approve Surplus Transfers
(Textbook Coordinators)

File Maintain Tables !nventnmmyansﬂers Inquiry Reports Query Record Security Help

=

Approvel/lnguire Requested
Approve Surplus Transfers

Request Surplus ‘ A
-

MISSISSIPPI DEPARTMENT OF EDUCATION

TEXTBOOKS INVENTORY MANAGEMENT SYSTEM
TIMS

Teobook Divvcicory
'\-I;a.l,ag._‘n'\g_-.vt ":f_\,--s.n_—.'n

* The Textbook Coordinator has the ability to change the status of surplus requested from
another District/School by clicking on the Request menu and selecting Approve Surplus
Transfers.

¢ Select a From School

The District/School is the place where the inventory will be moved from, and the To
District/School is the destination of the inventory. Once selected, the Approve Surplus
Transfers form will appear.
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Approve Surplus Transfers

File Maintain Tables |nventory Requests Transfers |nguiry Reports Query Record Security Help

F=E

e MISSISSIPPI DEPARTMENT OF EDUCATION
Z TEXTBOOKS INVENTORY
TIMS APPROVE SURPLUS TRANSFERS
District  School
{70130 [76207[MC LAURIN TEST SCHOOL | Total Qty
PE TE To To Transfer
Status Denial Reason ISBN-13 ISBMN-10 Qty Qty Dist  Sch  Transfer Option Date
APPROVED 7| --[ACTIVE TO SURPLUS [06/17/2014) 2!
DENIED =|[Water or Other Damage _— ' [ACTNE TO SURPLUS |[0519/2014)
[ -] [ do [acTIVE TO SURPLUS J[05/15/2014]
- ' 0828 [ACTIVE TO ACTIVE _ |[05/14/2014)
APPROVED |7} [0 --[ACTIVE TOACTIVE  [05/1412014)
*|(s & H Problems [ ol0%30 6280 [rCTIVE TOACTIVE  |[05/14/2014)—
7] [ 007306280 [aCTIVE TOACTIVE  |[05/13/2014)
APPROVED 7] [ 28]  o[o130]F0447 [acTIvE TO SURPLUS |[04/30/2014]
DENIED 7|[Gurrently In Use [ 150/[0%30] 0445 [AC TIVE TO SURPLUS |[04/28/2014)
APPROVED 7| [ 25 o0130) 6287 [ACTIVE TO SURPLUS |[04/25/2014]
APPROVED |7 [ 09369 M6268 (rc TIvE TO SURPLUS [04/1512014] +)
[ 150
Book Tite |DELIGHTS | Edtion| P | Copyright Year [2004 Inactive Ind ||
Publisher [HOUGHTON MIFFLIN COMPANY | Book Grade [ 02| Cost| 2150  Fiscal Year

The requested surplus for the selected school will display. Textbook coordinators may
select another school in their district by double clicking on the school field to display a
list of available schools.

Textbook Coordinators may change the status of requested surplus to Approved,
Denied, or they may leave the status blank. Should the status for an ISBN be changed to
Denied, a reason must be selected from the Denial Reason field.

Changes to this form can be saved by clicking Save on the File menu or click on Save

(%‘) icon on toolbar.

To exit without saving changes, select Exit from the File menu, or Click Exit button

( @'l) on the toolbar.
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Transfer Process

Request Transfer

File Maintain Tables Inventory Requests BIEWEEES Inquiry Reports Query Record Security Help

&

o

| i

ko

@ .'
TIMS

Tiscbook Dovenory
Management System

Request Transfer

Approvellnguire Transfers

Approvel/inguire Disposal Transfers

MISSISSIPPI DEPARTMENT OF EDUCATION
TEXTBOOKS INVENTORY MANAGEMENT SYSTEM

TIMS USER MANUAL
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Request Transfer

File Maintain Tables Inventory Requests Transfers |nguiry Reports Query Record Security Help
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" MISSISSIPPI DEPARTMENT OF EDUCATION
TEXTBOOK INVENTORY
TRANSFERS
From Dist/Sch | DEEW | 020 To Dist/Sch | 0130 | 020
Transfer Option

" Active to Active " Active to Surplus T Active to Disposal " Burplus to Active " Burplus to Disposal

IsBM| Copyrght|
10-Digit ISBN Book Title |
PEQuantty|  Publisher |
TE Quantity
Transfer Date ’7

Reason for Disposal | |

Disposal Method | |

* To transfer inventory from one type to another (such as Active, Surplus, or Disposal),
click Transfers on the main menu and select Request Transfer. Enter the district and
school numbers.

* After the From School is entered the user will be prompted to select a To
District/School. The From District/School is the place where the inventory will be
moved from and the To District/School is the destination of the inventory.

*  When the From Dist/Sch and To Dist/Sch have been populated, the Transfer form will
display.
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Request Transfer

File Maintain Tables Inventory Requests Transfers Inquiry Reports Query Record Security Help
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&: MISSISSIPPIDEPARTMENT OF EDUCATION
== TEXTBOOK INVENTORY
TIMS TRANSFERS
From Dist/Sch | TR | 020 To Dist/Sch | 0130 | 020
LeansforOnti
" Active to Active " Active to Surplus " Active to Disposal " Surplus to Active " Surplus to Disposal

ISBN Copyright |

10-Digit ISBN Book Title |

PE Quantity Publisher |
TE Quantity
Transfer Date

Reason for Disposal | |
Disposal Method | |

* Select the type of transfer to perform by clicking one of the five available transfer
options.

* The five types of transfer options are:

¢ Active to Active — must be done within the same district. The To Sch cannot be the
same as the From Sch.

* Active to Surplus — the From Dist/Sch and the To Dist/Sch must be the same or the
system will change it to what is in the From Dist/Sch.

* Active to Disposal — the From Dist/Sch and the To Dist/Sch must be the same or the
transfer option will be disabled.

* Surplus to Active — the From Dist/Sch and the To Dist/Sch must be the same or the
transfer option will be disabled.

* Surplus to Disposal — the From Dist/Sch and the To Dist/Sch must be the same or the
transfer option will be disabled.

**Disposals must be approved by the Office of Textbooks
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Request Transfer

File Maintain Tables Inventory Reguests Transfers |nquiry Reports Query Record Security Help
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g MISSISSIPPI DEPARTMENT OF EDUCATION
= TEXTBOOK INVENTORY
TIMS TRANSFERS
From Dist/Sch | 0130 To Dist/Sch | 0130

Transfer Option
® Active to Active T Active to Surplus = Active to Disposal = Surplus to Active  Surplus to Disposa

ISBN Copyright |

10-Digit ISBN Book Title |

PE Quantity Publisher |
TE Quantity
Transfer Date

Reason for Disposal | |

Disposal Method | |

* Transfer Option — Active to Active
* Click on Active to Active,

* Enter an ISBN and tab (The copyright, book title, publisher, and transfer date will
automatically populate).

* Enter the PE Quantity or TE Quantity to be transferred. If there was already a request
for this ISBN the system will display the previous request.

* Save the transfer by clicking File, then Save or click on Save ( Q‘) icon on toolbar.
The message “Transaction(s) added/updated successfully” will display.

* Note: Changes cannot be made to a transfer request once it has been saved. If by
chance invalid data was entered and saved, please contact the Textbook Coordinator to
deny the Transfer Request (by clicking Transfers on the main menu and selecting
Approve/Inquire transfers).
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Approve/Inquire Transfers
(Textbook Coordinators)

File Maintain Tables Inventory Bequestsmmquir}r Reports Query Record Security Help

'Eg E’ Request Transfer
T |‘Jx-.-}_

Approvel/lnguire Transfers

Approvel/inguire Disposal Transfers

e

@.’ MISSISSIPPI DEPARTMENT OF EDUCATION
TEXTBOOKS INVENTORY MANAGEMENT SYSTEM
TIMS

Tesbook Invenrory
Management System

To review transfer requests and to change the status of those requests, click Transfers
on the main menu and select Approve/Inquire Transfers.

* Select the school to be inquired on and click OK. The system will display the
Approve/Inquire Transfers form for the school that was selected.
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Approve/Inquire Transfers

File Maintain Tables Inventory Requests Transfers Inquiry Reports Query Record Security Help

=00

FROKE>®» =

MISSISSIPPI DEPARTMENT OF EDUCATION

4;-' TEXTBOOKS INVENTORY
TIMS APPROVE / INQUIRE TRANSFERS
- District  School
(704307 7020 MC LAURIN TEST SCHOOL | Total Qty
PE TE To Transfer
Status Reason for Denial ISBN-13 ISBN-10 Qty Qty Sch  Transfer Option Date
APPROVED ~ | J 5| o[0130][ 020 JACTIVE TO SURPLUS _J[06/17/2014) 2!
DENIED  ~|Condition of the Book || 9780618271269 |0618271260 | 232 0/ 0130 028 |aACTIVE TO SURPLUS  [05/19/2014]
[DENIED  ~|[o Reason or Method || 9780618271184 |061827118X)[ 20 0[0130[ 020 |ACTIVE TO SURPLUS  ||05/15/2014] -
[DENIED ~|No Reason or Method || 9780618271191 |0618271198 [ 91) 0/ 0130 020 |ACTIVE TO SURPLUS  |[05/15/2014]
[DENIED | ~|[No Reason or Method || 9780618271276 0618271279 [ 45) 0/ 0130 020 |aCTIVE TO SURPLUS  [05/15/2014]
[ - | 9780618271245 |0618271244 | 65| 0/ 0130 020 |ACTIVE TO SURPLUS  [05/15/2014] —
- | 9780618271191 | 0618271198 | 2| 0/0130] 092 JacTVE TOACTIVE  [05/14/2014]
APPROVED ~ || 9780618271214 |061827121%]| 75 00130 [ 028 JacTivE ToACTIVE 0571412014
~| Error || a780618271191 [0618271198 | 50| 0[o0130)[ 028 JacTvE ToACTIVE  [[05/14/2014]
- | 9780026599047 | 002659904X | 1) 0/0130] 028 JacTVE TOACTIVE  [05/13/2014]
APPROVED ~ || 9780026599047 |002659904%) 25 0/[0130 [ 044 |ACTIVE TO SURPLUS |[04/30/2014]+
ToTAL | 2,301 150
Book Title [MARKET PANTRY | Edition[ P_| Copyright Year [1990] Inactive Ind [ N_|
Publisher [BARNELL LOFT, LTD | Book Grade [ 04 Cost| 8999  Fiscal Year | 2013

* If you change the status to Denied the Reason for Denial has to be selected.

* To exit the form after viewing, click File, and then Exit or Click Exit button ( E-l) on the
toolbar.
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Reporting

Reports available in TIMS

Reports

Report Inventory
Status

Surplus Request

Publisher Listing

State Reports

History Reports

Security User Listing Report
Exclusion

) Active Listing
Active by Subject
Active by Grade
Surplus Listing
Surplus by Subject
Surplus by Grade
Disposal Listing
Transfer Listing

= IAN AT Aamvwy RAALIA A RAMLI™T™ @

guer].r Fecord Security Help

| Report Invento r
Status ¥
Surplus Request Surplus

Publisher Listing
State Reports ¥
History Reports *

Security User Listing Report
| Exclusion

mguew Record Security Help

| Report Inventory »
Status 4
| surplus Request
Publisher Listing
otate Reports »
History Reports ¥
Security User Listing Report
| Exclusion

| =az=""——— New Report

OF EDUCATION
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mguew Record Security Help

[ Report Inventaory L4
Status L4
Surplus Request

State Reports W Statistical Info Report
History Reports Catalog Listing
Security User Listing Report  § active Statewide Listing

| Exclusion Surplus Statewide Listing

s INVENTORY MA | Qisposal Statewide Listing

Surplus Requested Listing

guerjr REecord Security Help

I Report Inventory L4
Status L4
Surplus Reguest L4

Publisher Listing

History Reports
Security User Listing Repaort
| Exclusion

equested History
Transfer History
Prior Disposal Transfers

2 INVEMTARY MAMAMSEMENMT Ve
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MISSISSIPPI DEPARTMENT OF EDUCATION
TEXTBOOKS INVENTORY

| ACTIVE LISTING

District 0130 IHOWARD SCHOOL DISTRICT All Districts ™
School 020 IMC LAURIN TEST SCHOOL All Schools ™
Book Title |
Publisher |
ISBN |
RUN REPORT

* The TIMS application has many reports for your convenience.

* The Report Inventory section contains reports for Active and Surplus by Listing, Subject,
and Grade, Disposal Listing, and Transfer Listing.

* You may run the report with just the District/School that is selected or click the box next
to the school name that says All Schools to get a listing of all schools within your district.

* You may also double click on the school number to select another school.
* The report can be customized by entering a specific book title, publisher, or ISBN.
* After all entries have been made, click Run Report.

» After clicking Run Report, the report will display.
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MISSISSIPPI DEPARTMENT OF EDUCATION

TEXTBOOK INVENTORY
ACTIVE LISTING

07/15/2014
Dist  Sch ISBN-13 Book Title Copvyright Publisher PE Qtv  TE Qtv Cond Grade Subject Cost
978 MAERKET PANTRY 1980 BARNELL LOFT, LTD 73 1] NA 5] ADVANCED CHEMISTRY
07E0021473311 M-LATIN AMERICA AND 1009 MACMILANMOGRAW- kLo ] NA 08 SOCTAL STUDIES GR.6
CANADA, 1899 HILL SCHOOL D
97E0021475728 COMMUNITIES 1009 MCGRAW HILL 15 ] NA 03 SOCTAL STUDIES GE. 3 3100
9TE0021476050 UNITED STATES, 1099 1009 MCGRAW-HILL SCHOOL 158 o NA 03 SOCTAL STUDIES GR. 5
DIVISION
O7EO021482658 M -MISSISSIPPI 1909 GRADE 1000 MACMILANMCGRAW- 15 ] NA 04 MS HISTORY GRADE 4 33.00
4 HILL SCHOOL D
07E0021488230 M -COMMUNITIES 2000 2000 MACMILANMCGRAW- 50 ] NA 03 SOCTAL STUDIES GR.3 3100
GERALE 3 HILL SCHOOL D
07E0021488551 M-UNITED STATES. 2000 1009 MACMILANMOGRAW 163 ] NA 03 SOCTAL STUDIES GR. 5 4091
GRADE 3 HILL SCHOOL D
O7E0022442286 M -MCGRAW-HILL 1008 MACMILANMOGRAW- 335 ] NA 03 SPELLING GR. 3 1740
SPELLING, GR. 3, 1908 HILL SCHOOL D
9780022442293 M -MCGRAW-HILL 1988 MACMI LANMOGRAW- 13 ] NA 04 SPELLING GR. 4 1740
SPELLING. GR. 4, 1908 HILL SCHOOL D
97E0022442300 M -MCGRAW-HILL 1988 MACMI L ANMOGRAW 368 ] NA 03 SPELLING GR. 5 1740
SPELLING. GR. 5, 1908 HILL SCHOOL D
97E0022442316 M -MCGRAW-HIL 1988 MACMILLANMOGRAW- 39 o NA 06 SPELLING GR. 6 1749
SPELLING. GR. 8. 1908 HILL SCHOOL D
9780022743017 OTTO OPPOSITE 1085 MACMILAN 0 1 NA 0 READING 00
97E0022840680 M -HEALTH & WELLNMESS, 2008 MACMILLANMOGRAW- 100 ] NA 03 HEALTH 42.60
2008, GR.5 HILL INC
97E0026432150 GL -NUTRITION AND 2000 GLENCOEMCGERAW-HILL 5 ] NA 08-12 GENEEAL HOME ECONOMICS & 3300
WELLNESS. 2000 DUB CO LIVING SEILLS
97E0030154492 HEW-PSYCHOLOGY: 1988 HARCOURT SCHOOL 10 1] NA 08-12 PSYCHOLOGY 48.73
PRINCIPLES IN PRACTICE. DPUBLISHERS
1998
97E0131816380 PH WORLD STUDIES 2005 PRENTICE HALL s ] NA 06 SOCTAL STUDIES
'WESTEEN HEMISPHERE
OTE0153064135 HEJ-RHYTHM AND EHYME, 1007 HARCOURT SCHOOL 5 ] NA 01 READING READINESS-BASAL 1485
STU ANTHOLOGY, LEV K1, DUBLISHERS
1997
07B0153340437 HARCOURT SCIENCE 2002 HARCOURT SCHOOL 402 ] NA 03 SCIENCE GR. 5 4162
PUBLISHERS
07B0153340444 HARCOURT SCIENCE GRADE 2002 HARCOURT SCHOOL 458 ] NA 08 SCIENCE GR.§
§ PUBLISHERS
07E0382348014 AW -SILVEE. BURDETT GINN 2001 SCOTT FORESMAN 7 ] NA 01 MATHEMATICS GE 1 2286
MATHEMATICS, GR 1, 2001
97E0382363108 AW -MS SILVER BURDETT 2001 SCOTT FORESMAN 604 ] NA 03 MATHEMATICS GE. 3 41.93
GINN MATHEMATICS GE 3
2001
07B03823463115 AW -MS SILVER BURDETT 2001 SCOTT FORESMAN 721 ] NA 08 MATHEMATICS GR 6 4195
GIMN MATHEMATICS, GR.6,
200
0780358372156 M5 SCIENCE EXPLORER 2011 PEARSON EDUCATION 75 o NA o6 SCIENCE 7497
(PRENTICE HALL)
97B0558381500 M3 SCIENCE EXPLORER 2011 PRENTICE HALL 0 50 NA 08 SCIENCE
TEACHER EDITION
0780618271214 HM -HME MS. TREASURES. 2004 HOUGHTON MIFFLIN 150 ] NA o1 READING
GE 14, 2004 COMPANY
07B0618271283 EXPEDITIONS 2004 HOUGHTON MIFFLIN CO. 305 ] NA 03 READING
97B0618271290 TRIUMPHS 2004 HOUGHTON MIFFLIN CO. 380 1] NA 06 READING
0TE0618423637 HM SOCIAL STUDIES UNITED 2005 HOUGHTON MIFFLIN 114 ] NA 03 SOCTAL STUDIES
STATES HISTORY
97E0618611218 HM -HOUGHTON MIFFLIN 2005 48§ ] NA 03 ENGLISH 5148

ENGLISH, 2006, GR. 5
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** If your report does not display, please verify that your popup blocker is turned off **

"= MDE Home - Windows Internet Explorer

[@ http://www.mde.kl2.ms.us jo 'l 3 X @ MDE Home xI I

File Edit View Favorites IS Help

* Delete browsing history... Ctrl+Shift+Del
InPrivate Browsing Ctrl+Shift+P
Tracking Protection...

. 3 ActiveX Filtering ustor

Reopen last browsing session

Ensuring a b

Add site to Start menu PARENTS I
View downloads Ctrl+) e a1

Pop-up Blocker » l‘
SmartScreen Filter » Pop-up Blocker settings

Manage add-ons !

‘ : At MDE, w

Compatibility View settings e

leaming. T

parents, st

’ anyone in\

Windows Update find what y

F12 developer tools

Send to OneNote
Blog This in Windows Live Writer

Public Notices Caree

Internet options

- Mississippi Board of Education
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SECURITY USER LISTING REPORT

(Textbook Coordinator only)

The Security User Listing Report is a listing of all users in the district; it includes
first and last name of the user, the user name, and the role of the user.

e To obtain a Security User Listing, click Reports and select Security User
Listing Report.

File Maintain Tables Inventory Requests Transfers !nquir].fguer],f Record Security Help

= Report Inventary 4
‘ | ,Eg E’ Status L4
Surplus Reguest 4
Publisher Listing

State Repors 4
& History Reports L4

e = - Security User Listing Report

@ MISSISSI Exclusion | OF EDUCATION
TIMS TEXTBOOKS INVENTORY MANAGEMENT SYSTEM

Mook Linveitory
Management “ysten

e The Textbook Coordinator must then select a school for which to run a
report. The Run Report form will display.

e Click the box next to the school name that says All Schools to get a listing of
all schools within the district.
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File Maintain Tables Inventory Requests Transfers Inquiry Beports Query Record Security Help

e ey
= *
‘ T |¢;¢ @ L & J
i MISSISSIPPI DEPARTMENT OF EDUCATION
= TEXTBOOKS INVENTORY

Aleats

T
D Grh

| SECURITY USER LISTING REPORT

District [0130 HOWARD SCHOOL DISTRICT All Districts ™
School 020 IMC LAURIN TEST SCHOOL All Schools ™
Book Title |
Publisher |
ISBN |
RUN REPORT

e Click Run Report. After clicking Run Report, the report will display.
e |f the report does not display in the foreground, minimize the screens on
the desktop to see if the report is in the background.
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Things to Remember about TIMS

e Textbook inventory should be entered year round! When you receive

textbooks, please enter inventory into TIMS, immediately!

e Use the ISBN that is located inside the book on the copyright page.
o Textbooks that are 12 years or older should not be in the TIMS program! It
is an Accreditation violation. These textbooks should be transferred to

Disposal.

e Save after every tfransaction.

***Please subscribe to the TIMS Listserv to receive updates regarding TIMS.

*

Transparency MS | MS GOV | Follow MDE | MDE Email

» MISSISSIPPI
DEPARTMENT OF
| |EDUCATION

Ensuring a bright ﬁxtum for every child

Home About MDE

IN THIS SECTION

Curriculum and Instruction Home
* Staff

» Calendar

« Announcements

» Knowledge Base

e iTunes U

* FAQ

CONTENT AREAS

Advanced Leamning and Gifted
Programs

Business and Technology

Dyslexia

Early Childhood

English/L anquage Arts

Foreign Lanquage

Library Media

Mathematics

Physical and Health Education
Reading Fair

Science

Social Studies

Standards for Professional Learning
Textbook Adoption and Procurement
Visual and Performing Arts

OTHER LINKS

C&l SharePoint Site

Common Core State Standards
CCSS SharePoint Site
Mississippi Virtual Public School
RESA Registration

Unpacking the CCSS for ELA

News & Media

MS Schools Reports Public Notices Careers

Contact Us

EDUCATORS

Select MDE Office v

23

Textbook Adoption and Procurement

TIMS is down for End of Year Processing until July 15

TIMS (Textbook Inventory Management System)

TIMS Log-on

TIMS Security Form: User Profile
TIMS Security Form: School District
TIMS Contacts

Users Guide

New FAQs

Subscribe to List: Send a request to tims_list@mde k12 ms us. Please be sure to
include your name, school district, and email address

este

Textbook Resources
TIMS Log-on

Subscribe to the TIMS List

o
Adoption
Caravan
Catalogs
New Titles
SSL Update
Contacts
Coordinators

« School Books Supply Company of
Mississippi

= aapSchoolDivision NASTA
Adoption Schedule

« 2012-2013 MSIS District Book
Reauest Manual
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Subscribe to the TIMS List

I

e Enter email address
e First and Last Name (optional)
e C(Click on Subscribe
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Contact Information

Technical/Security Questions

Office of Technology and Strategic Services (OTSS) Help Desk 601-359-3959

E-mail MDEAPPS@MDE.12.MS.US

General TIMS Questions

Reset Passwords

Textbook Office-601-576-7950

E-mail tims@mde.k12.ms.us

Office of Textbooks
500 Greymont Avenue, Suite G
P.O. BOX 771
Jackson, MS 39205-0771
Phone (601) 576-4950
Fax (601) 354-7590
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